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SUMMARY: 19 
This protocol demonstrates a straightforward and robust method to study in situ axon growth 20 
and growth cone dynamics. It describes how to prepare ex vivo physiologically relevant acute 21 
brain slices and provides a user-friendly analysis pipeline. 22 
 23 
ABSTRACT: 24 
During neuronal development, axons navigate the cortical environment to reach their final 25 
destinations and establish synaptic connections. Growth cones—the sensory structures located 26 
at the distal tips of developing axons—execute this process. Studying the structure and dynamics 27 
of the growth cone is crucial to understanding axonal development and the interaction with the 28 
surrounding central nervous system (CNS) that enable it to form neural circuits. This is essential 29 
when devising methods to reintegrate axons into neural circuits following injury in fundamental 30 
research and pre-clinical context. Thus far, the general understanding of the growth cone 31 
dynamics is primarily founded on studies of neurons cultured in two dimensions (2D). Although 32 
undoubtedly fundamental to the current knowledge of growth cone structural dynamics and 33 
response to stimuli, 2D studies misrepresent the physiological three-dimensional (3D) 34 
environment encountered by neuronal growth cones in intact CNS tissue. More recently, collagen 35 
gels were employed to overcome some of these limitations, enabling the investigation of 36 
neuronal development in 3D. However, both synthetic 2D and 3D environments lack signaling 37 
cues within CNS tissue, which direct the extension and pathfinding of developing axons. This 38 
protocol provides a method for studying axons and growth cones using organotypic brain slices, 39 
where developing axons encounter physiologically relevant physical and chemical cues. By 40 
combining fine-tuned in utero and ex utero electroporation to deliver fluorescent reporters with 41 
super-resolution microscopy sparsely. Furthermore, a detailed toolkit description of the analysis 42 
of long-term and live-cell imaging data is included. 43 
 44 
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INTRODUCTION: 45 
Neurons are highly polarized cells that represent the basic computational unit in the nervous 46 
system. They receive and emit information that relies upon compartmentalization of input and 47 
output sites: dendrites and axons, respectively1. During development, axons extend while 48 
navigating an incredibly complex environment to reach their destination. Axon navigation is 49 
guided by the growth cone, a sensory structure located at the tip of the developing axons. The 50 
growth cone is responsible for detecting environmental cues and translating them into the 51 
dynamical spatial reorganization of its cytoskeleton2,3. The resulting morpho-mechanical 52 
reactions instruct the growth cone to extend or retract from the triggering cue, leading to specific 53 
axon maneuvers. 54 
 55 
The current understanding of axon extension and growth cone dynamics stems from studies 56 
evaluating axon growth over two-dimensional (2D) substrates2,4–7. These pioneering studies 57 
identified sophisticated interplay between growth cones and growth substrates and revealed 58 
striking differences dependent on substrate characteristics such as adhesiveness and stiffness8,9. 59 
Led by these insights, extracellular environmental cues were hypothesized to dictate axon 60 
growth, with the growth cone cytoskeleton executing this growth2,10–12. Notably, neurons can 61 
extend axons in non-adhesive substrates (e.g., poly-lysine, poly-ornithine)13. Moreover, substrate 62 
rigidity can influence axon growth rate independent of cell adhesive complexes8. Hence, studying 63 
growth cone dynamics in 2D substrates alone cannot accurately model the balance of forces that 64 
arise from the interaction of axonal growth cones with physiologically relevant three-dimensional 65 
(3D) environments, such as those found in vivo. 66 
 67 
To overcome the limitations of the 2D assays, axon growth and growth cone dynamics have been 68 
studied in 3D matrices8,9. These matrices pose more physiological context yet allow studying cell-69 
intrinsic mechanisms of axon growth. It enables growth cone examination in a single-cell fashion 70 
in a variety of conditions and pharmacological treatments9. In such 3D environments, axons 71 
displayed distinct cytoskeletal dynamics and grew faster than those observed in 2D cultured 72 
neurons9. These elegant studies demonstrated the influence of an extra dimension on the 73 
reorganization of the growth cone cytoskeleton and, consequently, on its behavior. 74 
 75 
Despite apparent advantages presented by 3D matrices over 2D surfaces in supporting native-76 
like neuronal development and axon growth, they remain a simplified synthetic scaffold that 77 
cannot reflect the complexity of dynamics observed in central nervous system (CNS) tissue. Here, 78 
delivery of reporter plasmids by ex utero and in utero electroporation was combined with brain 79 
organotypic slice culture and in situ live super-resolution imaging to analyze growth cone 80 
dynamics within a physiological context. This methodology allows visualization of developing 81 
axons while experiencing the 3-dimensionality of in vivo environments and the complexity of its 82 
physicochemical composition. Lastly, user-friendly procedures to measure axon growth and 83 
growth cone dynamics using commonly licensed and publicly available software are described. 84 
 85 
PROTOCOL: 86 
Animal experiments must comply with the relevant institutional and federal regulations. 87 
Embryonic day 15.5 and 12.5 (E15.5 and E12.5) pregnant female C57BL/6JRj mice were used in 88 



 

this protocol. Experiments were performed in accordance with the Animal Welfare Act of North 89 
Rhein-Westphalia State Environmental Agency (Landesamt für Natur, Umwelt und 90 
Verbraucherschutz (LANUV)). 91 
 92 
1. Preparation of plasmids for injection 93 
 94 
1.1. Isolate DNA using endotoxin-free Maxiprep kit according to manufacturer's protocol (see 95 
Table of Materials). 96 
 97 
1.2. Mix selected DNA at the desired concentration (Table 1) and 10% Fast Green solution (see 98 
Table of Materials) to visualize the delivery of DNA mixture into brain ventricles. 99 
 100 
NOTE: Specific plasmids were used for sparse labeling of the cortical neurons (Figure 1A), 101 
filamentous actin (F-actin) structures in the growth cone (Figure 1B), and dual-labeling of the 102 
growth cones within the same cortex (Figure 1C). All plasmids (Table 1) used in this protocol have 103 
been deposited in Addgene (see Table of Materials). 104 
 105 
1.3. Prepare glass capillaries using a capillary electrode puller set as per the following 106 
program: pressure: 500, heat: 800, pull: 30, and velocity: 40. 107 
 108 
1.4. Load 15 µL of DNA/Fast Green mix into each glass capillary using micro loader pipette tips. 109 
 110 
NOTE: Ensure that no bubbles form. 111 
 112 
1.5. Store DNA-filled capillaries in a 10 cm dish with a piece of modeling clay across the 113 
diameter of the dish. Capillaries can be loaded and stored at 4 °C the day before the experiment. 114 
Seal the back end of the capillary with flexible film to prevent drying. 115 
 116 
2. Preparation of solutions 117 
 118 
2.1. Prepare Hank's Buffered Salt Solution-supplemented with glucose (HBSS-G). 119 
 120 
2.1.1. Add 0.5% of 20% glucose to a bottle of 1x HBSS. Mix well and store at 4 °C for up to 2 121 
weeks. For the embryo extraction, bubble HBSS-G solution with carbogen (95% O2 and 5% CO2) 122 
using bubbling stone shortly before embryo collection. 123 
 124 
2.2. Slice media solution 125 
 126 
2.2.1. Prepare fresh slice media containing Neurobasal 1x, 5% horse serum, 5% foetal calf 127 
serum, B27 supplement 1:50, L-glutamin supplement 1:400, penicillin-streptomycin 1:200, and 128 
Neuropan-2 supplement 1:100 (at pH = 7.3), under sterile conditions (see Table of Materials). 129 
 130 
2.2.2. Prepare 3 cm dishes with 1 mL of slice media each. Place in the incubator at 35 °C with 131 
5% CO2 for at least 1 h before the experiment to equilibrate the media's pH through gas exchange. 132 



 

 133 
NOTE: The equilibration of the media's pH is caused by acidification of the media by the CO2 from 134 
the incubator. Slice media can be stored at 4 °C for up to 1 week. 135 
 136 
2.3. Low melt agarose solution (3%) 137 
 138 
2.3.1. Weigh the desired amount of low melt agarose powder and dissolve in an appropriate 139 
volume of 1x HBSS-G in a glass bottle. Approximately 7 mL of agarose solution per brain is 140 
needed. 141 
 142 
2.3.2. Place the bottle in a microwave for 2–3 min, with the cap loosely placed, and shake every 143 
10–20 s. 144 
 145 
2.3.3. Once the powder has completely dissolved, place the bottle in a water bath or bead bath 146 
set to 37 °C at least 1 h before the experiment to allow agarose to cool down. 147 
 148 
NOTE: It is recommended to heat the agarose twice over 15 min to ensure the agarose powder 149 
is dissolved. This is crucial for the proper adhesion of agarose to brain tissue. A thermometer 150 
should be used to measure the temperature of the agarose solution while embedding brains, 151 
making sure it is between 37–40 °C. Brains from different aged animals have different rigidity. It 152 
is recommended to test a range of agarose concentrations to find homogeny between tissue and 153 
agarose. 154 
 155 
2.4. Prepare Phosphate Buffered Saline with 0.3% Triton X-100 (PBS-T). 156 
 157 
2.5. Prepare Phosphate Buffered Saline with 0.2% Sodium Azide (PBS-NaN3). 158 
 159 
3. Preparation of the surgery station 160 
 161 
3.1. Clean the surgery station with 70%–96% ethanol and place operation underlay on the 162 
station surface. 163 
 164 
3.2. Sterilize the surgery instruments by rinsing with 70%–96% ethanol, followed by dry 165 
sterilization in a hot bead sterilizer. 166 
 167 
3.3. Clean platinum tweezer electrodes (see Table of Materials) with 70%–96% ethanol before 168 
connecting to the pulse generator. 169 
 170 
3.4. Insert a DNA/Fast Green-filled glass capillary into the capillary holder. Gently break off 171 
the capillary tip using fine scissors and test solution flow inside a 1.5 mL microcentrifuge tube 172 
filled with pre-warmed saline or water. 173 
 174 
NOTE: Figure 2A,B show surgery station set-up and tools used for ex utero electroporation (EUE) 175 
and in utero electroporation (IUE). 176 



 

 177 
3.5. For IUE, warm-up saline solution to 37 °C in a water bath. 178 
 179 
4. Embryo extraction 180 
 181 
4.1. Place pregnant mouse in anesthesia inducer chamber with 5% isoflurane until the mouse 182 
is deeply anesthetized. Confirm anesthesia by the absence of pedal withdrawal reflex. 183 
 184 
4.2. Transfer the mouse to an operation underlay and maintain isoflurane at 1.5%–2% through 185 
a nose cone. 186 
 187 
4.3. Apply ointment to both eyes to prevent corneal drying. 188 
 189 
4.4. Shave the mouse's abdomen, and then use 70%–96% ethanol-soaked gauze to remove 190 
shaved hair. Clean the area with betadine. 191 
 192 
4.5. Using sterile small surgical scissors, make a 2 cm skin incision along the abdominal 193 
midline, followed by a 1.5 cm muscle incision. 194 
 195 
NOTE: Incision size depends on the embryo size. Indeed, larger embryos will require a larger 196 
incision to accommodate their extraction. 197 
 198 
4.6. Cut a hole in the middle of the gauze sufficiently wide to fit the skin incision (~2 cm in 199 
diameter), soak it with warm saline, and place it around the abdominal opening. 200 
 201 
4.7. Pull out both uterine horns using a cotton bud soaked in warm saline or using forceps, 202 
carefully grabbing the spaces between embryos to pull them out. Place embryos on wet gauze 203 
(Figure 2C). 204 
 205 
NOTE: Small damage to blood vessels and capillaries around the uterine horns will likely result in 206 
profuse bleeding. Therefore, avoid direct handling of these vascularised areas at all times. 207 
 208 
4.8. Cut open the uterine sack and remove each embryo (Figure 2D). 209 
 210 
4.9. Euthanize each embryo immediately after extraction via a descending diagonal cut, 211 
ensuring complete spinal cord transection (Figure 2E). 212 
 213 
4.10. Place the embryos in a 10 cm dish containing HBSS-G on ice. 214 
 215 
NOTE: Beheading the embryo is avoided to prevent DNA/Fast Green mixture leakage from the 216 
brain and facilitate easy embryo positioning in the holder (see ex utero electroporation, step 5). 217 
 218 
4.11. Sacrifice the mother immediately after extraction of embryos by performing cervical 219 
dislocation. 220 



 

 221 
NOTE: Here, the mother is euthanized under anesthesia to spare it from any further post-222 
procedure pain or suffering in compliance with the protocol approved by the Animal Welfare Act 223 
of North Rhein-Westphalia State Environmental Agency (LANUV). 224 
 225 
5. Ex utero electroporation (EUE) 226 
 227 
5.1. Pick up an embryo and place it in the holder. 228 
 229 
NOTE: A cut 1 mL pipette tip attached to the end of a cell scraper is used as an embryo holder. It 230 
is essential to keep arms of embryos outside the tip during the procedure to prevent them from 231 
sliding into the tip (Figure 2F–I). The diameter of the pipette tip is easily adjustable to 232 
accommodate embryos of various sizes. Cut a second tip at length where the diameter of the tip 233 
matches embryo size and use it as an adapter insert to the holder mentioned above. 234 
 235 
5.2. Carefully insert DNA/Fast Green-filled glass capillary through the embryo's skull into the 236 
lateral ventricle and inject 2–3 µL of DNA plasmid mix (Figure 1A,B; Table 1) into each ventricle 237 
(Figure 2F). 238 
 239 
NOTE: Use the lambdoidal and sagittal sutures as a guide for the location of DNA injection. The 240 
lambdoidal and sagittal sutures are fibrous joints connecting the bone plate of the skull. The 241 
former joins the parietal bone with the occipital bone, and the latterjoins the two parietal bones. 242 
 243 
5.3. Hold the embryo's head between platinum tweezer electrodes at the appropriate angle 244 
to target the desired brain area (60° angle in this case), with the cathode facing the area where 245 
DNA transfer is intended (Figure 2G–H). 246 
 247 
5.4. Apply five pulses at 30 mV with an interval of 1 s and a duration of 50 ms using a square 248 
wave pulse generator. 249 
 250 
NOTE: Bear in mind that brains in EUE experience a more effective electric field than those in IUE. 251 
Hence, at a given DNA concentration, EUE results in higher efficiency of DNA transfer than IUE, 252 
and DNA concentrations need to be adjusted accordingly. 253 
 254 
5.5. If bilateral electroporation is desired, repeat steps 5.3–5.4 with the cathode and anode 255 
mirroring the previous position to target the contralateral cortex. 256 
 257 
NOTE: Since both ventricles were injected with DNA, cortices of both hemispheres were targeted. 258 
 259 
5.6. Place the electroporated embryo in a 6 cm dish containing ice-cold HBSS-G. Repeat steps 260 
5.1–5.6 for all embryos required. 261 
 262 
6. In utero electroporation (IUE) 263 
 264 



 

6.1. Inject pregnant mouse with analgesic; 50 µL of buprenorphine (0.1 mg/kg) (see Table of 265 
Materials) subcutaneously, 20 min before the procedure. 266 
 267 
6.2. Perform steps 4.1–4.8 from the embryo extraction section. 268 
 269 
NOTE: Avoid leaving embryos exposed unnecessarily by covering them with sterile gauze soaked 270 
in warm saline. 271 
 272 
6.3. Using fingertips, gently rotate the embryo inside the uterus until lambdoidal and sagittal 273 
sutures are located (Figure 2J). Carefully insert DNA/Fast Green glass capillary through the 274 
uterine wall and embryo's skull into the lateral ventricle and inject 2–3 µL of DNA plasmid mix 275 
(Figure 1A,C) into either one or both ventricles as desired (Figure 2K–L). 276 
 277 
NOTE: Excessive finger pressure on uterine horns could lead to amniotic sack collapse. 278 
 279 
6.4. Hold the embryo's head between platinum tweezer electrodes at the appropriate angle 280 
to target the desired brain area (60° angle in this case), with the cathode facing the area where 281 
the DNA transfer is intended. Avoid squeezing the uterus since it may cause the collapse of the 282 
amniotic sack (Figure 2M). 283 
 284 
6.5. Apply five pulses at 35 mV with an interval of 600 ms and a duration of 50 ms using a 285 
square wave pulse generator. 286 
 287 
6.6. If both lateral ventricles were injected, repeat steps 6.5–6.6 with the cathode and anode 288 
mirroring the previous position to target the contralateral cortex. 289 
 290 
6.7. Repeat steps 6.3–6.6 for all embryos required. 291 
 292 
6.8. Once all the required embryos have been electroporated, use a saline-soaked cotton bud 293 
to place uterine horns back inside the abdominal cavity gently. 294 
 295 
NOTE: The addition of saline solution into the peritoneal cavity will help uterine horns slide back 296 
into position. 297 
 298 
6.9. Suture muscle and skin incisions using 5-0 suture material. Use suture clips to secure the 299 
wound and disinfect the suture wound by spraying it with betadine (Figure 2N–P). 300 
 301 
6.10. Inject the mouse with 200 µL of 5% glucose subcutaneously. 302 
 303 
6.11. Inject the mouse with an antibiotic; 50 µL of Enrofloxacin (5 mg/kg) subcutaneously (see 304 
Table of Materials). 305 
 306 
6.12. Place the mouse back in the recovery cage and maintain warmth using a far-infrared 307 
warming light or heating pad for at least 20 min post-procedure (Figure 2Q). 308 



 

 309 
6.13. Monitor the mouse daily, and inject meloxicam regularly after the procedure for pain 310 
relief following institutional and federal guidelines. 311 
 312 
6.14. Extract embryos 2 days after the procedure (i.e., E17.5) following step 4. 313 
 314 
7. Brain extraction and embedding in agarose 315 
 316 
NOTE: It is recommended to carry out the following steps under a dissection microscope for 317 
better precision. Avoiding damage to the brain is critical for the success of the procedure. 318 
 319 
7.1. Set up extraction tools in a sterile working space under a dissection hood (Figure 3A). 320 
 321 
7.2. Separate the head of an embryo from the rest of the body using dissection scissors. 322 
 323 
7.3. Fix the head as shown in Figure 3C, and then remove the skin and skull by cutting along 324 
the midline, starting from the base of the head toward the nose (Figure 3D). 325 
 326 
7.4. Peel the skin and skull laterally, making a big enough gap (~1 cm) for the brain to be 327 
excised. 328 
 329 
7.5. To remove the brain, insert the closed tip of sterile dissection scissors, starting from under 330 
the olfactory bulb moving toward the brain stem (Figure 3E). 331 
 332 
7.6. Cut off the brain stem and trim any loose pieces of meninges around the brain (Figure 333 
3F). 334 
 335 
NOTE: Loose meninges often cause slices to remain attached to the agarose block after cutting, 336 
leading to detaching of tissue from the agarose during slice collection. 337 
 338 
7.7. Repeat steps 7.1–7.6 for all embryos and keep the brains on ice (ideally no longer than 30 339 
min) until the embedding step. 340 
 341 
NOTE: The following steps 7.7.1–7.7.4 refer to brain extraction of E12.5 brains. 342 
 343 
7.7.1. Isolate the top of the head just below the eye, as shown in Figure 3G. 344 
 345 
7.7.2. Cut the skin and skull on top of the brainstem, following the dashed line as shown in 346 
Figure 3H, without removing the brainstem. 347 
 348 
7.7.3. Make a 2 mm skin-skull incision at the back of the head, as shown in Figure 3I (see 349 
drawings for clarity). 350 
 351 



 

NOTE: This incision provides initial gripping points to peel off the layers of skin and skull. Typically, 352 
they come off as one layer. The typical incision size is 2 mm, corresponding to the length of the 353 
cutting edge of the used micro spring scissors. 354 
 355 
7.7.4. Start peeling off skin-skull layers by securing one side of the incision and pulling the other 356 
carefully. With the same care, finalize by peeling off the base of the head until freeing the brain 357 
(Figure 3J). 358 
 359 
NOTE: This must be done with great care, observing that the brain is not being pulled along the 360 
tissue layers. Alternate sides to remove the tissue covering the brain. 361 
 362 
7.8. Pour warm agarose (at 37–40 °C) in a 3 cm dish. 363 
 364 
7.9. Pick up the brain using a perforated spoon and remove excess liquid by dabbing the 365 
bottom of the spoon against dry tissue paper. Place the brain in an agarose dish. 366 
 367 
NOTE: It is essential to remove as much liquid from around the brain as possible to allow for 368 
better adhesion of agarose to the tissue. 369 
 370 
7.10. Put the dish with liquid agarose on ice. Using a smaller spoon, mix agarose for 10 s for 371 
even cooling. Maneuver the brain to the middle of the dish. Place the brain horizontally in the 372 
dish with the dorsal side up, ensuring it is completely covered with agarose from all directions 373 
(Figure 3K). 374 
 375 
NOTE: Brains will often sink to the bottom of the dish once placed in agarose; lift the brain using 376 
a small spoon until a gap of 1–2 mm under the brain is established. 377 
 378 
7.11. Repeat steps 7.8–7.10 for all brains. 379 
 380 
7.12. Once agarose has polymerized, add 500 µL of HBSS-G on top of the agarose block to 381 
prevent drying. Then, cover the dish with ice. 382 
 383 
NOTE: Keep the sample on ice for 5 min before sectioning to allow the brain temperature to reach 384 
4 °C. 385 
 386 
8. Organotypic slice culture 387 
 388 
NOTE: Clean vibratome and surrounding surfaces with 70%–96% ethanol to avoid slice 389 
contamination. The set-up of the vibratome workstation (see Table of Materials) is shown in 390 
Figure 3B. 391 
 392 
8.1. Fill the vibratome buffer tray with cold HBSS-G and the outer tray with ice to maintain the 393 
HBSS-G cold throughout the procedure. 394 
 395 



 

8.2. Continuously supply HBSS-G in the buffer tray with carbogen using a bubbling stone. 396 
 397 
8.3. Using a fresh blade, make a large cut (~2 x 2 cm) around the brain and remove a block of 398 
agarose containing the brain, with enough surrounding agarose to trim the agarose into a small 399 
rectangle block. 400 
 401 
NOTE: This step allows adjusting the block's angle so that the sagittal axis of the brain is 402 
perpendicular to the vibratome plate and the coronal axis aligns parallel to the blade. Leave 403 
around 5 mm of agarose at the dorsal side of the brain for easy handling of the slices. 404 
 405 
8.4. Place a small drop of fast-adhesive solvent-free superglue in the middle of the specimen 406 
holder and spread to an area that will cover the bottom of the agarose block. 407 
 408 
8.5. Gently pick up the agarose block and dry the bottom by dabbing against tissue paper. 409 
Place the block on the glued area of the specimen holder, with the rostral side of the brain up. 410 
Put the specimen holder on ice and allow the glue to dry for 1 min. 411 
 412 
8.6. Once the glue has dried, place the specimen holder in the buffer tray. 413 
 414 
8.7. Cut the brain in coronal slices at an angle of 15°. 415 
 416 
NOTE: The thickness of the slices can vary depending on the application. Here, brains were sliced 417 
at a thickness of 150 µm. Set vibratome speed to 1.0–1.5 mm/s for trimming excess agarose on 418 
top and trimming olfactory bulbs. Reduce cutting speed to 0.5 mm/s for collecting cortical slices 419 
for analysis. Most vibratomes can be paused to collect each slice. If reducing the quality of slices 420 
or detaching of tissue from agarose are experienced, replacing the vibratome blade can help. 421 
 422 
8.8. Using clean spatulas, collect brain slices and place them on Polytetrafluoroethylene 423 
(PTFE) membrane, immobilized in a 35 mm glass-bottomed dish using paraffin (up to five brain 424 
slices/ membrane) (Figure 3L-M). 425 
 426 
NOTE: Fix the PTFE membrane inside a 35 mm glass-bottomed dish using wax. This will stabilize 427 
the membrane when adding the slice culture media and also during imaging. 428 
 429 
8.9. Using a 200 µL pipette, remove excess HBSS-G from around the slices on the PTFE 430 
membrane, leaving the slices semi-dry. 431 
 432 
8.10. Add 500 µL of slice media (pre-warmed to 35 °C) directly to the space under the PTFE 433 
membrane. 434 
 435 
NOTE: No bubbles must form under the membrane when adding the media. This will leave whole 436 
or partial slices with no media exchange. Replace 200 µL of media every 2 days in culture or after 437 
every imaging session. 438 
 439 



 

8.11. Incubate the slices at 35 °C with 5% CO2. 440 
 441 
9. Immunohistochemistry 442 
 443 
9.1. Fix slices with 1 mL of 4% paraformaldehyde (PFA)—supplemented with 4% sucrose—per 444 
dish. Incubate at RT for 30 min. 445 
 446 
CAUTION: When handling PFA, wear a lab coat and gloves. Perform fixation steps under a 447 
chemical hood, and dispose of PFA waste appropriately. 448 
 449 
9.2. Wash the slices twice with 300 µL PBS for 5 min. Transfer the slices to a 24-well plate. 450 
 451 
NOTE: The experiment can be paused at this stage. Add PBS-NaN3 to the slices and store at 4 °C. 452 
NaN3 is a toxic compound; when handling solutions with it, wear a lab coat and gloves. Steps 9.3–453 
9.10 are to be performed in an orbital shaker. 454 
 455 
9.3. Quench the slices with 300 µL of 0.1 M glycine at 4 °C overnight. 456 
 457 
9.4. Wash out glycine with PBS at RT 3x for 10 min. 458 
 459 
9.5. Permeabilise the slices with 300 µL of PBS-T at RT for 2 h. 460 
 461 
9.6. Block using 10% goat serum in PBS-T at RT for 2 h. 462 
 463 
9.7. Add 300 µL of primary antibody (anti-vimentin antibody at a dilution of 1:200; see Table 464 
of Materials) diluted in 10% goat serum in PBS-T solution at 4 °C overnight. 465 
 466 
NOTE: In steps 9.8–9.12, slices were light-protected to prevent loss of fluorescence. 467 
 468 
9.8. Wash primary antibody with PBS at RT 3x for 20 min. 469 
 470 
NOTE: PBS was used instead of PBS-T to wash out Triton X-100. 471 
 472 
9.9. Add 300 µL of secondary antibody (either Alexa Fluor 488 or 647 at a dilution of 1:400; 473 
see Table of Materials) in PBS at RT for 2 h. 474 
 475 
NOTE: DAPI is added immediately after removing the secondary antibody at a dilution of 1:10,000 476 
for 5 min. 477 
 478 
9.10. Wash the secondary antibody with PBS at RT 3x for 20 min. Wash with distilled water 2x 479 
for 1 min. 480 
 481 
9.11. Transfer the slices to a glass slide using a fine brush, and then dry at 30 °C for 20 min. 482 
 483 



 

9.12. Mount the slices using an aqueous mounting medium. Keep the slides at RT overnight for 484 
the mounting media to curate. 485 
 486 
10. Imaging acquisition 487 
 488 
NOTE: Regardless of the DNA delivery approach (IUE or EUE), slices were analyzed at the same 489 
developmental age range (E17.5–E18.5). IUE allows neuronal progenitors to divide and develop 490 
for two further days in vivo. EUE, on the other hand, allows for the tracking of early 491 
developmental events. 492 
 493 
10.1. Switch on the chamber incubator and set it to 35 °C with 5% CO2—ideally 4 h before 494 
imaging—to allow microscope components to equilibrate at 35 °C. 495 
 496 
10.2. For deep imaging of slices, use water-immersion objectives to reduce the mismatch in 497 
refractive index between the tissue and objective. 498 
 499 
NOTE: Here, super-resolution imaging mode was used. Imaging through the PTFE membrane 500 
requires an objective with a long working distance (~1 mm). If a long working distance objective 501 
is unavailable, slices may be transferred to an 8-well glass-bottomed dish. To transfer slices, add 502 
1 mL of slice media to the top of the membrane, and then use a spatula to lift a slice and transfer 503 
it to a well containing 200 µL of media. Remove excess media using a 1 mL pipette tip leaving the 504 
slices semi-dry. 505 
 506 
10.3. For imaging axon growth, locate a region of the cortex with low to medium cell density. 507 
For imaging growth cone dynamics, locate a growth cone in the cortex's intermediate zone or 508 
subventricular zone. 509 
 510 
10.4. Define a z-stack size in the image processing software (see Table of Materials). For axon 511 
growth in a large z-stack, set a step size of 2 µm. For growth cones in a smaller z-stack, set a step 512 
size of 1 µm. 513 
 514 
NOTE: Always account for potential movement of the growth cone and axon through the x, y, 515 
and z planes. Axons grow at a much higher rate in organotypic cultures than in in vitro cultures. 516 
Here, a z-stack of around 80 µm to image axon growth was sufficient. For growth cone dynamics, 517 
a z-stack of ~6 µm was adequate. 518 
 519 
10.5. For imaging axon growth of neurons in a larger area, define a tile scan. 520 
 521 
10.6. Use the lowest laser power possible to minimize the chances of bleaching growth cones 522 
during acquisition. 523 
 524 
10.7. For imaging axon growth, acquire time-lapses for 2 h with an interval of 5 min. For imaging 525 
growth cone dynamics, acquire time-lapses for 2–5 min with an interval of 2.5–3 s. 526 
 527 



 

11. Data analysis 528 
 529 
11.1. Measure the speed of axon growth using kymographs 530 
 531 
11.1.1. Open the image file in Fiji14 through File > Open and select the image. 532 
 533 
11.1.2. Obtain the maximum intensity projection of the time-lapse through Image > Stacks > Z-534 
Projection > Maximum Intensity Projection. 535 
 536 
11.1.3. Go through the time-lapse and locate a growing axon. 537 
 538 
11.1.4. Once located, draw a line through the growing axon. Start from the tip of the axon in the 539 
first frame, and follow the axon through the entire time-lapse. 540 
 541 
11.1.5. Generate a kymograph using the plugin KymoResliceWide. 542 
 543 
11.1.6. Set the scale of the kymograph by going to Image > Properties. Set the distance in µm in 544 
Pixel Width and set the time in s or min in Pixel Height. 545 
 546 
11.1.7. Go to Analyze > Measure. 547 
 548 
NOTE: An angle relative to the x-axis will be given. 549 
 550 
11.1.8. Calculate the speed of axon growth by substituting the angle in the following equation: 551 
SIN(RADIANS(θ))/COS(RADIANS(θ)) in a spreadsheet. 552 
 553 
11.2. Measure the volume of the growth cone using an image analysis software (see Table of 554 
Materials). 555 
 556 
11.2.1. Open the image file in the image analysis software through File > Open and select the file 557 
of interest. 558 
 559 
11.2.2. Select the Add New Surfaces wizard. 560 
 561 
NOTE: A section on the lower-left corner will appear with six steps for manual editing. 562 
 563 
11.2.3. In step 1—under Algorithm Settings—select Segment Only A Region Of Interest. In step 564 
2, crop the frame to fit the entire growth cone in all frames. 565 
 566 
11.2.4. Keep thresholding to Absolute Intensity in step 3, and ensure the entire growth cone 567 
region is thresholded in step 4. 568 
 569 
11.2.5. In step 5, select Number of Voxels lmg = 1 under Filter Type. 570 
 571 



 

NOTE: In the last step, multiple measurement sets may be created. Here, only one measurement 572 
was created for volume. 573 
 574 
11.2.6. Select the Execute button to perform all the creation steps and terminate the Add New 575 
Surfaces Wizard. 576 
 577 
11.2.7. In the Statistics tab at the top of the wizard window, select Specific Values and Volume 578 
under the Detailed tab. 579 
 580 
REPRESENTATIVE RESULTS: 581 
Representative results obtained with the described method workflow are shown. E15.5 mice 582 
were used in the present demonstration, though this protocol is easily adapted to virtually all 583 
embryonic ages ranging from E11 to late E17. In this protocol, either ex utero electroporation 584 
(EUE; Figure 2A, 2C–I) or in utero electroporation (IUE; Figure 2B,C, and 2J–Q) were used to 585 
deliver plasmids into the progenitor neurons lining the lateral ventricles. These progenitors are 586 
the source of future cortical projecting neurons (CPN)15,16. Plasmid mixes were prepared to drive 587 
sparse neuron-specific expression of either membrane-targeted (Lyn)-mNeonGreen (Figure 1A) 588 
or LifeAct-enhanced (E)GFP (Figure 1B) to evaluate the overall behavior and actin dynamics in 589 
growth cones, respectively. Furthermore, a plasmid mix aimed to label individual neurons with 590 
either turbo(t)-RFP or zoanthus sp. (Zs) green fluorescent protein (ZsGreen) (Figure 1C) was 591 
included. This facilitates the monitoring of growth cone behavior from independent neighboring 592 
neurons. 593 
 594 
Brain dissection from electroporated embryos is a crucial step that needs to be carefully 595 
performed to obtain high-quality slices, preserving the native brain structure. Dissection 596 
instruments and vibratome were prepared beforehand and carefully ethanol-sterilized (Figure 597 
3A,B). Next, the heads of electroporated embryos were carefully dissected and the brains were 598 
extracted. Here, representative dissection of brains from the embryos subjected to EUE at E15 599 
(Figure 3C–F) and E12.5 (Figure 3G–J) are shown. Brains are immediately encased in an agarose 600 
matrix, sliced, and placed on PTFE membrane inserts within a bottom-glass dish for incubation 601 
(Figure 3K–M). 602 
 603 
The health status of brain slices is a significant point for control to ensure reliable results. A visual 604 
inspection for any contamination was performed daily. Additionally, once the culture was 605 
finalized, the brain slices are fixed and subjected to immunohistochemistry. Here, 4′,6-diamidino-606 
2-phenylindole (DAPI) was used to control the overall cellular organization and vimentin staining 607 
to reveal glial organization; particularly, radial glia (RG) scaffold. Typically, successfully cultured 608 
brain slices derived from either IUE or EUE show normal cellular distribution as revealed by DAPI 609 
and a somewhat organized array of RG with apically oriented pial-contacting processes17 (Figure 610 
4A,B respectively). Occasionally, marked disturbances in the RG scaffolding in cultured brain 611 
slices are observed, especially in those derived from EUE electroporation (Figure 4C). Brain slices 612 
with extremely disorganized RG scaffold show impaired neuronal migration and defective axon 613 
growth (not shown). Hence, controlling the RG scaffold is an easy post-culture method to sort 614 
the data obtained from reliable brain slices. 615 



 

 616 
Brain slices derived from either IUE or EUE with Lyn-mNeonGreen-expressing plasmid mix result 617 
in similar sparse neuron labeling. A representative pyramidal CPN expressing Lyn-mNeonGreen 618 
and the dynamic behavior of its growth cone is shown as an example (Figure 5A and 619 
Supplementary Video 1, top left). In addition, neurons were labeled using a plasmid expressing 620 
an actin probe to analyze actin dynamics of axonal growth cones in situ (Figure 5B and 621 
Supplementary Video 1, bottom left). In situ experiments were also performed with a dual-622 
Cre/Dre fluorophore-expressing plasmid design (Figure 1C and Supplementary Video 1, right). 623 
tRFP or ZsGreen fluorophores in this plasmid could be specifically and individually activated by 624 
either Dre or Cre recombinases, respectively, in neighboring neurons (Figure 5C). This 625 
experimental line-up allows side-by-side analysis of growth cones from control neurons with 626 
neighboring modified neurons (any given loss or gain of function). This circumvents variability 627 
arising from the use of different slices to test control and experimental conditions. 628 
 629 
Kymographs generated from the recorded movie were analyzed, from which dynamic growth 630 
parameters such as protrusive activity over time and growth length can be easily obtained (Figure 631 
6A). Note that a simple adjustment in the temporal resolution of the time-lapse allows 632 
measurement of axon elongation speed for 2 h (Figure 6A). Furthermore, the variation of growth 633 
cone volume over time—a measure of general growth cone dynamic activity—can be easily 634 
obtained, in this case with licensed software (Figure 6B and Figure 6E,F). This can be used to 635 
evaluate the speed of actin treadmilling and the balance of filopodia/lamellipodia during growth 636 
cone exploring activity. 637 
 638 
FIGURE AND TABLE LEGENDS: 639 
 640 
Figure 1: Schemes of the plasmids used in the protocol. (A) pCAG-lox-STOP-lox-Lyn-641 
mNeonGreen. (B) p-Tub-alpha-1-LifeAct-GFP. (C) pCAG-lox-rox-STOP-rox-tRFP-pA-lox-ZsGreen-642 
pA. Relevant information regarding plasmid components and fluorophore's origin is found in the 643 
boxes.  644 
 645 
Figure 2: Workflow of ex utero and in utero electroporation of E15.5 mice. (A) Set up of surgery 646 
station for ex utero electroporation. (B) Set up of surgery station for in utero electroporation. (C) 647 
Uterine horns pulled outside the abdominal cavity of the anesthetized mouse. (D) Extraction of 648 
an embryo from the uterine sack. (E) Embryo sacrifice by complete spinal cord transection via a 649 
diagonal incision; note that beheading was avoided. (F) Placement of embryo in the holder and 650 
injected with DNA/Fast Green mixture into the left lateral ventricle. (G,H) Position the embryo's 651 
head between platinum tweezer electrodes with the cathode (red arrow) over the cortex at a 60° 652 
angle. (I) Placement of embryo's arms (black arrows) outside the holder to prevent sliding of the 653 
embryo during the procedure. (J) Rotation of the embryo inside the uterine sack to expose the 654 
head. (K,L) Injection of DNA/Fast Green mixture into embryo's lateral ventricles through the 655 
uterine wall. (M) Position the embryo's head between platinum tweezer electrodes with a 656 
cathode (red arrow) over the cortex at a 60° angle. (N) Sutured muscle incision via running locking 657 
suture. (O) Sutured skin incision via an interrupted suture. (P) Securing of the wound using 658 
surgical wound clips and disinfection using betadine. (Q) Placement of the mouse in the recovery 659 



 

cage with far infrared warming light. 660 
 661 
Figure 3: Extraction of E15.5 and E12.5 brains and organotypic slice culture procedure. (A) Tools 662 
used for the brain extraction procedure. (B) Set up of organotypic culture station. (C–F) Extraction 663 
of E15.5 brain. (G–J) Extraction of E12.5 brain. Dotted lines highlight the location of incisions. Red 664 
arrows are pointing out the direction of pulling by forceps. (K) Embedding the brain in a 3 cm dish 665 
containing 3% low melt agarose, leaving a 1–2 mm agarose spacing gap under the brain. (L) 666 
Collection of 150 µm brain slice. (M) Placement of brain slices on PTFE membrane inserts 667 
immobilized in a 35 mm dish using paraffin film (blue arrow). Red star marking indicates a given 668 
brain slice collection from vibratome (L) and its transfer to PTFE membrane (M). 669 
 670 
Figure 4: Conserved radial glial cell structure in healthy organotypic slices. Confocal images of 671 
E17.5 brain slices revealing RG array (vimentin; green) and overall cell organization (DAPI; 672 
magenta) following IUE (A) and EUE (B,C). Note the strong disturbances in the RG array that may 673 
occasionally result from EUE (C). Magnifications correspond to the red dotted frames in the main 674 
figure: scale bars, 10 µm. 675 
 676 
Figure 5: In situ visualization of the growth cone dynamics in acute organotypic slices. (A,B) 677 
Neurons and their corresponding growth cones labeled with Lyn-mNeonGreen and LifeAct-GFP, 678 
respectively. Red star marking growth cone of Lyn-mNeonGreen expressing neuron. Blue asterisk 679 
marking growth cone of LifeAct-GFP expressing neuron. (C) Neighboring neurons labeled with 680 
the dual plasmid system containing tRFP (magenta) and ZsGreen (green) and their corresponding 681 
growth cones. Growth cones imaged (right) were outside the captured frame (left), obtained 682 
shortly after acquiring the growth cone time-lapse; scale bars, 5 µm. 683 
 684 
Figure 6: Analysis of axon growth speed and growth cone volume. (A) Axon tracing on a neuron 685 
expressing Lyn-mNeonGreen (top) and its corresponding kymograph (below) generated using 686 
ImageJ. (B) Reconstruction of z-stack video of growth cone using the image analysis software 687 
(top) and the same growth cone highlighted using the surfaces measurement tool (below). (C) 688 
Graphs showing changes in growth speed over time for several axons. (D) The average growth 689 
speed of axons is quantified in (C). (E) Graph showing the changes in the growth cone volume 690 
over time. (F) The average volume of growth cones is quantified in (E); scale bar, 5 µm. 691 
 692 
Figure 7: Radial migration and neuronal polarization of pyramidal cortical neurons. Diagram 693 
illustrating developing pyramidal cortical neurons (pink) migrating radially from the germinal 694 
ventricular zone (VZ) toward the pia surface. Guided by radial glia processes (gray), migrating 695 
polarized neurons establish a leading process, future dendrite, and trailing process, future axon, 696 
that continue to extend downward toward the intermediate zone (IZ). Dashed red boxes 697 
represent the cortical areas where growth cones were imaged. Specifically in the IZ, 698 
subventricular zone (SVZ), or joining axon bundles (green). The illustration was created with a 699 
web-based tool, BioRender.com. 700 
 701 
Table 1: List of plasmids used in the Protocol. Name, concentration, and intended use of each 702 
utilized plasmid. 703 



 

 704 
Supplementary Video 1: In situ visualization of the growth cone dynamics in acute organotypic 705 
slices. Dynamics of growth cones labeled with Lyn-mNeonGreen (top left) and LifeAct-GFP 706 
(bottom left). Neighboring growth cones are differentially labeled with the dual plasmid system 707 
containing tRFP (magenta; top right) and ZsGreen (green; bottom right). Imaging interval, 2.5 s. 708 
Scale bars, 5 µm. 709 
 710 
DISCUSSION: 711 
How the growth cones sense and react to their surrounding environment to coordinate 712 
simultaneous axon extension and guidance is still a matter of debate3,18. Pioneering studies in 2D 713 
substrates provided a glimpse into the fundamental molecular mechanisms generating the forces 714 
that drive growth cone dynamics during axon formation, outgrowth, and navigation2,10–12,19. 715 
More recently, studies in 3D matrices revealed how much influence a third dimension has in the 716 
behavior of the growth cone and consequently in axon growth8,9. Nevertheless, the intricate 717 
mechanisms instructing growth cone dynamics in vivo remain to be thoroughly examined. 718 
 719 
Preparation of organotypic slice cultures from IUE or EUE brains is widely utilized and well-720 
documented. It has become a golden standard allowing scientists to gain insights into the 721 
development and behavior of neurons in the living brain tissue20,21. Indeed, this technique has 722 
been successfully utilized in combination with various high-resolution imaging techniques to 723 
visualize specific molecular processes and morphological events in situ. Such studies include, but 724 
are not limited to axon formation and extension19,22, cortical neuronal migration19,22–24, 725 
centrosome dynamics25,26, microtubule dynamics27, as well as the functional dynamics of pre-and 726 
postsynaptic compartments28,29. 727 
 728 
This protocol addresses a gap in experimental neurobiology, visualizing the growth cone 729 
dynamics of developing cortical neurons in situ, in ex vivo acute brain slice cultures, and the tools 730 
to analyze the data obtained. 731 
 732 
Acute brain slice cultures were utilized to establish this protocol because they (1) with some 733 
practice, are easy to generate; (2) present an accessible system to study growth cones embedded 734 
in a quasi-fully-physiological environment, yet transparent enough to allow high-resolution live-735 
cell imaging; (3) can be expanded for its use with a myriad of transgenic mouse lines; (4) 736 
combined with either IUE or EUE, provide virtually unlimited potential to deliver molecular tools 737 
to evaluate the performance of growth cones and axons in vivo under loss/gain of function 738 
regimes, along with fluorescent reporters and cytoskeleton probes. 739 
 740 
This methodology was described in the context of both EUE and IUE. Although still a highly 741 
reliable method, EUE resulted in an increased incidence of brain slices showing a disorganized RG 742 
network compared to those obtained with IUE as a delivery method (Figure 4C). Disturbances in 743 
the RG array strongly affect neuronal migration and the pattern of axon elongation30,31. These 744 
are key parameters that predict where to find axons for analysis at a given time and the type of 745 
environment they are navigating. Brain slices with a significantly disrupted RG network typically 746 
have impaired cortical neuron stratification. This, in turn, produces axons with chaotic 747 



 

trajectories. Therefore, it is strongly recommended to control for the structural integrity of the 748 
RG network. Interestingly, poor structural integrity correlates with increased age of the 749 
embryonic brain. Indeed, such effects in younger E12.5–E13.5 embryos were typically not 750 
observed19. 751 
 752 
The present protocol is thorough and straightforward. Nevertheless, there are a few critical steps 753 
where special care and attention must be taken to obtain optimal results. These have been 754 
expressly noted in the protocol and include (1) tuning the amount of DNA used in the 755 
electroporation to get sparse labeling; (2) avoiding damage during the extraction of brains; (3) 756 
controlling the temperature of the agarose during brain casing; (4) troubleshooting the ideal 757 
percentage of agarose for brains of a given age; and (5) selection of fluorophores, the experience 758 
of which follows. During protocol optimization, the performance of several fluorophores in live-759 
cell in situ imaging was tested. Monomeric GFP variants EGFP and NeonGreen for the preparation 760 
of the LifeAct- and Lyn-tagged plasmids were chosen for this protocol (Figure 5A,B). Additionally, 761 
the RFP variant mScarlet was tested and found highly suitable for this set-up (data not shown). 762 
Multimeric tRFP (dimer) and ZsGreen (tetramer) (Figure 5C and Supplementary Video 1, right) 763 
were also tested. These fast-folding super-bright fluorophores are recommended when the 764 
method requires rapid fluorescent signal generation after DNA delivery. 765 
 766 
A common practice in using slice cultures is to utilize slices from different brains to test control 767 
and experimental conditions. This represents an inherent source of unwanted variability. Here, 768 
an expression system that enables independent modification of neighboring neurons and 769 
reporters' expression for identification was used. Note that in this demonstration (Figure 5C), 770 
there were no differences between neurons expressing either of the fluorophores. However, as 771 
an example, such a plasmid mix combined with a transgenic mouse line harboring a Cre-sensitive 772 
gene will label with tRFP (Dre-sensitive) neurons that remained as wild type. In contrast, the 773 
ZsGreen (also Cre-sensitive) will label the recombined neurons. Hence, growth cones of the two 774 
different genotypes, and likely also phenotypes, could be studied side-by-side simultaneously in 775 
the same brain slice. 776 
 777 
Localization of axons and growth cones for analysis is an important consideration. Cortical 778 
neurons polarize while radially migrating from the ventricular zone (VZ) toward the cortical plate 779 
(CP). During this process, neurons form a leading process (a future dendrite) and a trailing process 780 
that will become the axon, eventually joining pioneering axons in the intermediate zone (IZ), 781 
establishing axon tracts32. Therefore, to capture axonal growth cones, imaging was done on 782 
axonal fibers in the IZ, including axons exiting the CP and early-generated axons already 783 
associated with axonal bundles; or eventually, in fibers that transverse the IZ and extend below 784 
it (Figure 7). 785 
 786 
This protocol makes it feasible to perform super-resolution imaging of neurons within 787 
organotypic slices. Historically, light scattering was a significant problem faced when imaging 788 
thick specimens. Over the last two decades, extensive advances in optical technologies made 789 
imaging of thick specimens possible. Here, a long working distance objective was used to visualize 790 
smaller structures better, such as growth cones. Unavoidably, this protocol does not capture 791 



 

more detailed events such as retrograde actin flow or microtubule dynamics. The long-working 792 
distance objective, which necessitates a lower Numerical Aperture (NA), preserves information 793 
from thick slices. However, it was also possible to adapt this protocol to use with objectives of 794 
shorter working distance. This required a smooth transfer of slices to a glass-bottomed dish to 795 
preserve structural integrity. However, using this method resulted in shorter survival—~15 h—796 
due to loss of gas exchange (data not shown). Unlike 2D cultures, growth cones in 3D occupy a 797 
larger volume and require movement-artifact compensation in the z-axis. To increase the ability 798 
to image detailed events, modern confocal technology must be utilized. Therefore, it is 799 
recommended to use a fast-scanning z-stack motor, such as the z-Galvo available on highly 800 
sensitive confocal microscopes33. 801 
 802 
Of note, this protocol presents three main limitations. First, it is often challenging to control levels 803 
of expression/number of expressing cells of any given plasmid in vivo. This introduces variability 804 
between all slices even when maintaining the same plasmid concentration. Therefore, the 805 
selection of the regulatory elements in the expression vectors used must be predetermined with 806 
care. Second, imaging detailed events using membrane inserts is currently not feasible. This 807 
second limitation may be overcome with the methodological updates proposed in the previous 808 
paragraph. Lastly, growth cones are highly photosensitive and can quickly become 809 
photobleached. Therefore, frequent imaging of the growth cones, for as little as 5 min using laser 810 
scanning microscopes can often collapse the growth cones. In this regard, new advancement in 811 
light-sheet microscopy generated devices can be adapted for long-term imaging of the brain 812 
slices34. 813 
 814 
Protocols of this like are envisioned to open new research avenues, allowing a better 815 
understanding of what it takes for a growth cone to read and react toward a complex in vivo 816 
environment, and more importantly, to unravel the mechanics of this sophisticated interplay. 817 
 818 
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Plasmid Concentration (µg/µL)

pCAG-lox-STOP-lox-Lyn-mNeonGreen 0.25

+ +

p-Tub-alpha-1-iCre 0.08

pCAG-lox-rox-STOP-rox-tRFP-lox-Lyn-ZsGreen 1

+ +

p-Tub-alpha-1-iCre 0.004

+ +

p-Tub-alpha-1-Dre 0.2

p-Tub-alpha-1-LifeAct-GFP 0.125
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Response to the editor’s comments on JoVE63068: 
"In-situ visualisation of axon growth and growth cone dynamics in ex-vivo embryonic 

brain slice cultures" 
 
We thank the editors for their constructive criticism on our manuscript, which indeed 
helped improve it. In the following, we address the editors’ comments. 
 

1- The editors made several comments regarding checking rewarded sentences. 
 
All these sentence restructures have been checked/edited. All changes can be tracked in the 
revised manuscript 
 

2- The step numbers are changed as per the journal style. Please check. 
 
Step numbers throughout the manuscript have been checked/edited, including step 
numbers referred to within the text. 
 

3- The highlighted steps identify the essential steps of the protocol for the video, i.e., the 
steps that should be visualized to tell the most cohesive story of the Protocol. The 
highlighting should be restricted to 3 pages of the Protocol including headings and 
spacings. However, in the present version, the highlighting exceeds 3 pages (4.5 
pages). Please check/edit. Please ensure that there is a logical flow from one 
highlighted step to the next and is in line with the Title of the manuscript. 

 
Highlighted content within the manuscript have been edited to comply with the 3-page 
limit. 
 
 
To aid the editor, besides the track changes in the document we include below a point-by-
point summary of all the modifications in this revised version. 
 

4- Line 95. Can this be specified? The type/sequence? 
 
Different DNA plasmids were prepared, and here we refer to them in general. All plasmids 
used are now individiually mentioned in figure 1, and table 1. Addgene deposit numbers for 
these plasmids are also noted in table of materials. 
 

5- Line 95 How this is ensured? 
 
The commercial DNA purification kit utilized here includes an step where a specific buffer 
(formulation non-disclosed) is used to remove contaminating bacterial endotoxins. This kit is 
advertised by the company to result in purified endotoxin-free DNA. Therefore, no 
additional steps were taken in this protocol to further ensure this. 
 

6- Line 98. Could you please specify the conc? 
 
Concentration of DNA plasmids used is now mentioned in table 1. 
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7- Editor made this new table with the plasmid details. Please check/edit if needed. 

 
Table created by editors have been checked/ edited 
 

8- Line 107. Please mention the units. 
 
There are no units associated to these numerical values. They are indeed arbitrary units 
reflecting a position in a range of values from a "Ramp test" rather than unit-defined. That is 
why these values are typically reported in a unitless way in the literature. 
 
The reason is that these values are defined by the specific properties of the heating filament 
used which can vary from devise to devise even within the same devise manufacturer.  
Therefore the above values must be individually calibrated by the end user for each devise 
by performing a Ramp test. 
 

9- Lines 136-137. How this takes place? 
 

the equilibration of the media's pH is caused by acidification of the media by the CO2 from 
the incubator. 
 

10- Line 204-205. Please specify the dimension 
 
Dimension of hole in gauze added. The sentence now reads “Cut a hole in the middle of the 
gauze sufficiently wide to fit the skin incision (approximately 2 cm in diameter), soaked it 
with warm saline, and place it around the abdominal”. 
 

11- Line 262. Please mention the equipment/set-up where these parameters will be 
applied 

 
Information on equipment used for this part of the experiment is added to lines 264-265 
and table of materials. The sentence now reads " Apply 5 pulses at 30 mV with an interval of 
1 s and a duration of 50 ms using a square wave pulse generator.” 
 

12- Lines 224-225. Please provide a NOTE mentioning why this step is performed. 
 
Note added to lines 227-229. It reads “NOTE: Here, the mother is euthanized under 
anesthesia to spare it from any further post-procedure pain or suffering in compliance with 
the protocol approved by the Animal Welfare Act of North Rhein-Westphalia State 
Environmental Agency (LANUV).” 
 

13- Line 243. Is it possible to mention which specific mix to be used here? 
 
1.1. Information added. The step now reads “Carefully insert DNA/Fast Green-filled glass 
capillary through the embryo’s skull into the lateral ventricle and inject 2-3 µL of DNA 
plasmid mix (Figure 1A-B; Table 1) into each ventricle (Figure 2F).” 
 



14- Line 261. Please write the correct step numbers. 
 
Step number added in the revised manuscript. The sentence now reads “If a bilateral 
electroporation is desired, repeat steps 5.3-5.4 with the cathode and anode mirroring the 
previous position to target the contralateral cortex.” 
 

15- Line 262. Why this is specifically targeted? 
 
Since both ventricles were injected with DNA, cortices of both hemispheres were targeted. 
 

16- Please provide a brief NOTE regarding what are these. These will help the readers to 
understand better 

NOTE added to the “ex utero electroporation” section where the terms were first 
mentioned in lines 246-248. It reads “NOTE: Use the lambdoidal and sagittal sutures as a 
guide for the location of DNA injection. The lambdoidal and sagittal sutures are fibrous 
joints connecting bone plate of the skull.  The formal joins the parietal bone with the 
occipital bone, and the lateral joins the two parietal bones.” 

 
17- Line 312-313. Any specific wavelength needed? 

 
No specific wavelength is required for this step, any far-infrared warming light will be 
sufficient to keep the animal warm. 
 

18- Line 332. Can this be approximately quantified? 
 
Information on gap size is added in the revised manuscript. 
 

19- Line 338. How to ensure that all the meninges pieces are removed? 
 
It is not necessary to remove all the meninges, only loose pieces are removed. 
 

20- Line 344-345. How long these can be kept in ice? 
 
Information regarding recommended length the brains are kept on ice are added to the 
revised manuscript. The step now reads “Repeat steps 7.1-7.6 for all embryos and keep the 
brains on ice (ideally no longer than 30 min) until the embedding step.” 
 

21- Line 403. Can this dimension be specified? 
 
Dimension added. The step now reads “Using a fresh blade, make a large cut (approximately 
2 x 2 cm) around the brain and remove a block of agarose containing the brain, with enough 
surrounding agarose to trim the agarose into a small rectangle block.” 
 

22- Lines 428-429. Please define the abbreviation 
 



Abbreviation defined. The step now reads “Using clean spatulas, collect brain slices and 
place them on Polytetrafluoroethylene (PTFE) membrane, immobilized in a 35 mm glass-
bottomed dish using paraffin (up to 5 brain slices/ membrane) (Figure 3L-M).” 
 

23- Line 478. Please ensure that the details of the primary and secondary antibodies are 
added in the table of materials. 

 
Information on all antibodies used are added to the table of materials. 
 

24- Lines 556-557. Do you need to film this step? 
 
The step does not need to be filmed. Highlight has been removed. 
 

25- The protocol doesn’t mention about vimentin staining.  Can few steps be included in 
the Protocol section regarding this? How was this done? Also please include the 
details of the nrcessary reagents in the table of materials 

 
There is indeed a full section related to this staining “Immunohistochemistry” (447-490). 
Details about antibodies used and their concentrations are now added to the protocol 
section (page 497). In addition, all antibodies used were added to the table of materials. 
 

26- This Figure is missing. Please add 
 
Figure is now added to the revised submission file. 
 
 
 



 
Response to the editors and Reviewers’ comments on JoVE63068: 

"In-situ visualisation of axon growth and growth cone dynamics in ex-vivo embryonic brain slice 
cultures" 

 
 
We thank all editors and reviewers for their constructive criticism on our manuscript, which indeed 
helped improve it. In the following, we address the editors and reviewers’ comments point-by-point. 
 
Editorial comments: The editors made several comments to be changed by the authors, those are 
addressed below:  
 
1. Please take this opportunity to thoroughly proofread the manuscript to ensure that there are no spelling or 
grammar issues. 

 
The revised manuscript was thoroughly proofread and checked for spelling and grammar issues.  
 
2. Please revise the text to avoid the use of any personal pronouns (e.g., "we", "you", "our" etc.). 

 
All personal pronouns were removed in the revised manuscript. Please note that minor sentence 
changes were made to accommodate the requested changes without modifying the sentence 
message. All other changes can be tracked in the revised manuscript.  
 
3. JoVE cannot publish manuscripts containing commercial language. This includes trademark symbols (™), 
registered symbols (®), and company names before an instrument or reagent. Please remove all commercial 
language from your manuscript and use generic terms instead. All commercial products should be sufficiently 
referenced in the Table of Materials (including reagents, instruments, software, etc.). Please sort the Materials 
Table alphabetically by the name of the material. 
For example, Parafilm, Eppendorf 
 

The revised manuscript was checked for any commercial language. The trade names Parafilm and 
Eppendorf were removed and replaced with the more generic names flexible film (now line 131) and 
Microcentrifuge tube (now line 195), respectively.  
 
4. Please adjust the numbering of the Protocol to follow the JoVE Instructions for Authors. For example, 1 
should be followed by 1.1 and then 1.1.1 and 1.1.2 if necessary. Please refrain from using bullets or dashes. 
 

Numbering of steps in the protocol were checked and the revised protocol follows the numbering 
guidelines stated.  
 
5. Please note that your protocol will be used to generate the script for the video and must contain everything 
that you would like shown in the video. Please ensure you answer the “how” question, i.e., how is the step 
performed? Alternatively, add references to published material specifying how to perform the protocol action. 
There should be enough detail in each step to supplement the actions seen in the video so that viewers can 
easily replicate the protocol. 

 
All steps mentioned in the protocol were checked for clarity, wherever necessary, a reference 
addressing the specific step was added for the reader’s benefit.  
 
6. Please add more details to your protocol steps: 
 
Line 103: Please specify the concentration used. 

 

Rebuttal Letter Click here to access/download;Rebuttal
Letter;Rebuttal_letter_R1.docx

https://www.editorialmanager.com/jove/download.aspx?id=1378550&guid=44b430e5-c0bd-4c1d-a8e6-42cc02738279&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1378550&guid=44b430e5-c0bd-4c1d-a8e6-42cc02738279&scheme=1


Now in line 104. We adjusted the wording of step 2 of the “preparation of plasmids for injection” 
section to make it clear that the concentrations used are described in steps 2.1, 2.2 and 2.3. 
 
Line 119: Please include the details of the capillary puller set in the Table of Materials. 

 
 
Details of the capillary puller is included in row 11 of the materials table as “DMZ universal electrode 
puller”. 
 
Line 194: Please replace “Eppendorf” tube with “microcentrifuge” tube. 

 
Now in line 195. The commercial name of this item was changed in the revised manuscript. 
 
Line 231: Please mention how the euthanization was performed. 

 
Now in line 236. The language used was clarified in the revised protocol (step 9 of the “embryo 
extraction” section) to emphasise on the method used to euthanise the embryos. It now reads 
“Euthanise each embryo immediately after extraction via a descending diagonal cut ensuring 
complete spinal cord transection” 
 
Line 263: Please clarify how the electric impulses were applied. What equipment was used for the  
same? Also please include the equipment detailsin the Table of Materials. 

 
Platinum tweezer electrodes used to deliver electrical pulses during both EUE and IUE protocols are 
stated in their respective section: EUE now in lines 265 till 269; IUE now in lines 300 – 305. More 
details about the equipment can be found in row 50 of the table of material as “Platinum 
Tweezertrodes”. 
 
Line 354: Please mention the incision size. 
 

Now in line 368. The Incision size is added to step 7.3 of the “brain extraction and embedding in 
agarose” section. 
 
7. In the software, please ensure that all button clicks and user inputs are provided throughout. Also, please 
ensure that the button clicks are bolded. 

 
The manuscript has been carefully proofread to ensure all button clicks and user inputs are included. 
Button clicks and user inputs have been highlighted in the revised manuscript. In addition, previous 
point 1.6 and 1.7 were expanded for clarity.  
 
Before “1.6 Set scale of kymograph in image properties.  Set the distance in µm in “pixel width” and 
set the time in sec or min in “pixel height”.”  
Now, line 568: Set scale of kymograph by going to “image” then “properties”.  Set the distance in 
µm in “pixel width” and set the time in sec or min in “pixel height”. 
 
Before “1.7 Using the measurement tool in Fiji, the angle relative to the x axis is given.”  
Now, line 571: 1.7 Go to “analyse” then “measure”.  Angle relative to the x axis will be given. 
 
 
8. Figure 6: Please include the description of (E) in the figure legend. 
 



The legend of figure 6 has been corrected to include the description of (E). It now states “Graph 
showing changes in growth cone volume over time.”. Now lines 711-712. 
 
9. Figure 6B: In the y-axis description, please write as Speed (µm/h) instead of Speed (µm/hour). 
 

The units in the y-axis in figure 6B was changed to (µm/h) in the revised manuscript. 
 
10. Please include a supplementary video of the growth cone dynamics and reference the same in the Results 
section. 

 
A supplementary video showing dynamics of all growth cones in figure 5 have been included as a 
supplementary video. The supplementary video was also referenced in the results section in lines 
641, 643 and 644. 
 
11. Please include limitations of the protocol in the Discussion section. 

 
A paragraph in the discussion was included in the revised protocol reflecting the three main 
limitations of this protocol. Now lines 821-835. 
 
12. Please do not abbreviate the journal titles in the References. 

 
 
Journal names have been modified in the revised manuscript to include the full names of journals as 
requested.  
 
Reviewer 1: This reviewer states that the present method is well-described and is relevant for 
developmental biology. This reviewer also highlighted the fact that parts of the present protocol 
specifically in utero and ex utero electroporation as well as the organotypic cultures of brain slices 
have been previously described, and recommended to reference previous work related to this 
protocol.  
 
Major Concerns: 
This is not the first time this protocol has been described. There are plenty of manuscripts describing neuronal 
differentiation in the developing cortex (brain slices). Therefore is commendable to cite previous work related 
to this protocol. For instance, there habe been reports describing neuronal migration, axon formation, 
neurogenesis. More importantly, subcellular events have been imaged during neuronal development in brains 
slices (e.g., centrosome and microtubule dynamics). 
 
We indeed agree with this reviewer comment. The present protocol combines, and fine-tunes, pre-
stablished protocols to achieve the visualisation of growth cone dynamics in situ, a feat not 
addressed by previous studies. As suggested by this reviewer, we added a paragraph in the 
discussion mentioning previous work related to our protocol. These are now noted between lines 
738 and 745, see below. 
 

“Preparation of organotypic slice cultures from IUE or EUE brains is widely utilised and well-
documented.  It has become a golden standard allowing scientists to gain insights into the 
development and behaviour of neurons in the living brain tissue 20,21.  Indeed, this technique has 
been successfully utilised in combination with various high-resolution imaging techniques to 
visualise specific molecular processes and morphological events in-situ.  Such studies include, but are 
not limited to: axon formation and extension 19,22, cortical neuronal migration 19,22-24, centrosome 
dynamics 25,26, microtubule dynamics 27 as well as the functional dynamics of pre- and postsynaptic 
compartments 28,29.” 
 



 
Reviewer 2: This reviewer finds this manuscript interesting and necessary in the field to study 
behaviour of growth cones and axon growth in a physiological context. The reviewer finds the 
protocol to be clear and easily reproducible. This reviewer is particularly appreciative of the detailed 
description of data analysis.  
 
Major Concerns: 
In Figure 6, B and E panels, it seems as it only one axon/growth cone was recorded and plotted. It will be very 
interesting for the reader to know the variability of the measurements made by using this protocol and plot the 
average of several recorded axons/growth cones. Alternatively, the same panels B and E including the 
measurements for several individual neurons would be also helpful. 

 
The reviewer points out to the fact that only one axon/growth cone was recorded and plotted in 
figure 6B and E and suggests including several other data points would increase the reader’s interest. 
As suggested by this reviewer, in the revised protocol, we have increased the data points in figure 
6C-F to show the variability in growth speed and change in volume of growth cones in-situ. 
 

 
Minor concerns: 
I would include some more detailed explanation in the figure legends. For instance: 
1) Explain what the "star" means in Figure 3, panels L-M. 

 
This is now explained in the legend of Figure 3, now line 663. It now reads “Red star marking 
indicates collection of a given brain slice from the vibratome (L) and its transfer to PTFE membrane 
(M).“. 
 
2) Indicate the parafilm in panel M, Figure 3. 

 
An arrow is added in Figure 3 indicating this. Now line 662-663, figure legend reads “Placement of 
brain slices on PTFE membrane inserts immobilised in a 35 mm dish using paraffin (blue arrow).”  


